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1.0. Introduction 
1.1. Purpose of this guide 

The purpose of this guide is to describe how to set up profiles on the User Profile Maker (version 
3.2.0 or later) for use with BGAN LaunchPad (version 3.2.0 or later).  
 

1.2. Scope 
This document provides an overview of User Profile Maker, gives instructions on installing the 
application, and explains how to create and edit user profiles for use with BGAN LaunchPad. 
 

1.3. Who should read this manual 
This document is intended for administrators who want to set up user profiles for use on BGAN 
LaunchPad Corporate Edition  
 

1.4. Associated documents 

• BGAN LaunchPad Help. 
• “Using TFTs on BGAN” – Solutions Guide document that explains how Application Traffic Flow 

Templates (TFTS) work, and how to set one up. This document is available for download from 
www.inmarsat.com/bgansolutions 

• “Using VPNs over BGAN” – Solutions Guide document that explains how to use Virtual Private 
Networks (VPNs) over BGAN. This document is available for download from 
www.inmarsat.com/bgansolutions 
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2.0. Introducing the User Profile Maker 

NOTE: User Profile Maker is only available to users of the Corporate Edition of BGAN 
LaunchPad. 

NOTE: This document is for use with version 3.2.0 (or later) of the User Profile Maker, and 
version 3.2.0 (or later) of BGAN LaunchPad. If you are running earlier versions, 
obtain the latest version from the product CD, or from Inmarsat customer services. 

The User Profile Maker is used by the BGAN administrator to create one or more profiles for use 
with BGAN LaunchPad. Each profile defines the data connections available in BGAN LaunchPad, the 
access restrictions applied to each user, and allows you to define any additional support information. 
 
Once you have created a profile, you can then associate one or more user logins and passwords 
with it. This user login and password enables the selected user(s) to log in to BGAN LaunchPad, and 
gives them access to the profile and its associated settings.  
 
Each profile defines the following information: 
• The Data Connections available to a logged in user. You can define a single IP data connection, 

or a number of data connections depending on the complexity of your organization’s activities. 
When setting up a profile, you also define the associated QoS and routing information. Refer to 
“Configuring Data Connections” on page 6. 

 NOTE: The Corporate Edition of BGAN LaunchPad does not come pre-configured 
with data connections. Therefore you must create at least one user profile if you 
intend to use BGAN LaunchPad to manage your data connections. 

• The Restriction settings applied to the logged in user. There are three levels of restriction, 
ranging from no restriction, where the user has access to all BGAN LaunchPad menu items, to 
maximum restriction, where BGAN LaunchPad management functions are barred to the user. 
Refer to “Configuring Restrictions” on page 12. 

• The additional Support details that you want to display in BGAN LaunchPad. This is usually the 
support contact details within your organization. Refer to “Configuring Support details” on page 
15 

  
For an example of how to set up a user profile, refer to “Setting up a Profile – Example” on page 21. 
 
By creating profiles, and assigning usernames and passwords to each profile, your organization has a 
large measure of control over the level of access each user has to BGAN LaunchPad, and so to the 
BGAN service. 
 
Note the following about the User Profile Maker (UPM): 
• If you want multiple users to have access to the same profile, simply create the profile and assign 

multiple user logins to it.  
• You can configure and create profiles for use either on a standalone computer, or across a 

network of computers. 
• The User Profile Maker is supplied with a default profile, which has the login and password 

“Admin”. Inmarsat recommends that you delete this login after you have created and tested your 
own user logins.  

• The application is designed solely to help you manage access to BGAN LaunchPad, and does not 
have security features. By default, the profiles, and associated login and password details are 
stored in a generally accessible directory on the computer. If you want the User Profile Maker 
and associated profiles to be completely secure, you must implement your own security 
measures.  
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2.1. Installing User Profile Maker 
You must install the User Profile Maker if you intend to use the Corporate Edition of BGAN 
LaunchPad. You can install User Profile Maker from the BGAN LaunchPad installation CD. 
 
To install User Profile Maker on your computer: 
1. Insert the Inmarsat BGAN LaunchPad Installation CD into your computer's CD-ROM drive. You 

are given a choice of four directories on the CD. 
2. Choose the correct directory for your computer, depending on your operating system.  
3. Click on the installer, and follow the on-screen instructions.  
4. When prompted, select Other Installation Options, and then select BGAN LaunchPad 

User Profile Maker, and follow the on-screen instructions. 
 
User Profile Maker is installed on your computer, and the following icon displays on your desktop: 

 
 

3.0. Creating a User Profile 
To create a user profile, click on the User Profile Maker icon on your desktop: 
 

 
 
The following screen is displayed. The default profile, if any, is displayed: 
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 Note the following when creating a connection:  
• You must go into each of the tabs in User Profile Maker, and complete all mandatory fields, 

before you can save the profile. 
• You are not prompted to save the profile and assign the user name(s) and password(s) for the 

profile until you have completed all the fields. The Save button is greyed out until you complete 
all the required fields. 

• You can add as many data connections as required to a profile.  
• If at any time you want to clear all the existing settings for a profile, click on the File menu, and 

select New. You will be asked to confirm the operation. Click Yes to confirm. 
 

3.1. Configuring Data Connections 
This section describes how to set up one or more data connections for this user profile. To do this: 
 
1. In User Profile Maker, select the Connections tab. The Connections screen displays, as shown 

below: 
 

 
 

2. Click on Add new connection. 
 
NOTE: If you want to edit an existing connection, select the icon and select “Edit”. 
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The Connection configuration screen displays, as shown below: 
 

 
 
This screen gives you the option of creating the following types of data connection: 
• Standard IP or Streaming IP Connection. This type of connection is shared between all 

users connected to the terminal. You can configure a standard IP data connection and one or 
more streaming IP connections for your profile, but only one of these connections can be open 
at any one time. The characteristics of each are as follows: 
o The standard IP data connection is suitable for most basic data requirements, for example 

email, Internet browsing and FTP. It is a best effort connection, and is usually charged by the 
amount of data sent. 

o A streaming IP data connection delivers a guaranteed data rate and is useful if, for example, 
you want to eliminate delay. It is more suited to applications such as video streaming or audio 
streaming. The available data rates for a streaming IP data connection are 32kbps, 64kbps, 
128kbps or 256kbps. (The data rates available to you depend on the terminal you are using.) 
If required, you can configure more than one streaming IP data connection, each at a different 
data rate. A streaming IP data connection is usually charged by the amount time that the 
connection is live. 

• Dedicated Streaming IP Connection. If required, you can set up one or more dedicated 
streaming IP data connections for specific applications such as Streambox, Win Media and Quick 
Time. A dedicated connection ensures that the selected application does not have to share a 
connection with any other traffic. In addition, you can open more than one dedicated connection 
at a time if required.  
You must already have configured and opened a standard IP or streaming IP connection 
(described above) before you can open a dedicated streaming IP connection. This is because the 
dedicated connection shares the APN and routing information of the open standard or streaming 
IP connection. 
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• VPN Connection If you require extra security when transmitting data, you can add a Virtual 
Private Network (VPN) connection to BGAN LaunchPad. This configures BGAN LaunchPad to 
support the use of a VPN application on your computer.  
There are two types of VPN: split tunnel and inclusive tunnel. Use the VPN Connection option 
only if you want to create an inclusive tunnel VPN. In addition, note that if you create an 
inclusive tunnel VPN, communications between BGAN LaunchPad and the terminal are closed 
down when the connection is open. 
Refer to “Using VPNs over BGAN”, available for download from 
www.inmarsat.com/bgansolutions, for details on split tunnels and inclusive tunnels.  
 

For detailed descriptions on configuring each of these connection types, refer to the following 
sections. 
 
Configuring a Standard IP or Streaming IP Data Connection 
To configure a standard IP or streaming IP data connection, from the Connection configuration 
screen:  
 
1. Click on Create new Standard IP or Streaming IP Data connection, and click on OK. 

The Primary Connection screen is displayed: 
 

 
 

2. Type in a name for the connection in the Icon label text box, for example “Standard IP” or 
“Streaming IP”. The IP data icon and this name display when you open the Data tab in BGAN 
LaunchPad. 

3. Select an IP Data service. This can be either Standard or Streaming. 
• If you chose Standard, no further configuration is required in this part of the screen. Go to 

step 4. 
• If you choose Streaming, the Streaming Parameters section of the window activates. 

You can do the following in the Streaming Parameters section of the window:  
a. Select the Desired Rate from the drop-down list. This is the symmetrical rate that 

you want to use for this connection.  
b. Select the Minimum Rate from the drop-down list. This is the minimum symmetrical 

rate that you will accept for this connection. Inmarsat recommends that you set the 
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Minimum Rate to the same as the Desired Rate, to ensure that you are allocated the 
data rate that you require. 

c. Change Error correction status. Error correction is turned off by default. Inmarsat 
strongly recommends that you do not turn on error correction, unless instructed to 
do so.  

4. If the drop-down box is activated, select an APN from the Select APN drop-down list. If it is 
not activated, only the default APN is available.  

5. In the IP Configuration section, set up your IP Address requirements. Select either Use 
Dynamic (Network Assigned IP Address) or Use Static IP Address. If you select Use 
Static IP Address, enter the IP Address in the text box.  

6. In the IP Configuration section, set up your DNS Server requirements. Select either Use 
Dynamic (Network Assigned) DNS Servers or Use Static DNS Server. If you select 
Use Static DNS Server, enter a Primary DNS Server and, if required, a Secondary DNS 
Server in the text box.  

7. If required, check the Use Header compression check box to turn on header compression.  
8. Click on Apply to save the displayed configuration, and continue editing the connection, click on 

OK to save the displayed configuration and exit the configuration screens, or click on Cancel to 
edit without saving.  

 
If you want to add another data connection to the profile, click on Add New Connection in the 
Connections tab. 
 
Configuring a Dedicated Streaming IP Data Connection 
To configure a dedicated streaming IP connection, from the Connection configuration screen:  
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1. Click on Create new Dedicated Streaming IP Data connection, and click on OK. The 
Dedicated connection screen is displayed: 
 

 
 

2. Click on the icon you want to use for this application. The icon displays in the box next to the 
Icon label text box. 

3. Type in a name for the connection in the Icon label text box. The name and icon that you 
select here will display when you open the Data tab in BGAN LaunchPad.  

4. Select the application you want to associate with this icon and icon label from the Application 
Traffic Flow Template drop-down list. The traffic flow template ensures that only traffic 
associated with the application can use this dedicated connection.  
NOTE: BGAN LaunchPad is supplied with a number of pre-configured Traffic Flow 
Templates that display on this drop down list. If the application you want to use does 
not display on the list, you or your Service Provider must write an appropriate 
traffic flow template. Refer to “Associated documents” on page 3 for details on 
where to obtain instructions for writing a template, 

5. Select the Desired Rate from the drop-down list. This is the symmetrical rate that you want to 
use for this connection.  

6. Select the Minimum Rate from the drop-down list. This is the minimum symmetrical rate that 
you will accept for this connection. Inmarsat recommends that you set the Minimum Rate to the 
same as the Desired Rate, to ensure that you are allocated the data rate that you require. 

7. If required, change Error correction status. Error correction is turned off by default. Inmarsat 
strongly recommends that you do not turn on error correction, unless instructed to do so.  

8. Click on Apply to save the displayed configuration, and continue editing the connection, click on 
OK to save the displayed configuration and exit the configuration screens, or click on Cancel to 
edit without saving.  

 
If you want to add another data connection to the profile, click on Add New Connection in the 
Connections tab. 
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Configuring a VPN IP Data Connection 
Only use these instructions if you want to create an inclusive tunnel VPN. If you are not sure of the 
VPN connection type you want to create, refer to “Using VPNs over BGAN”, available for 
download from www.inmarsat.com/bgansolutions. 
 
To configure a VPN connection, from the Connection configuration screen:  
1. Click on Create new VPN IP Data connection, and click on OK. The VPN connection 

screen is displayed: 
 

 
 

2. Type in a name for the VPN in the Icon label text box. The VPN icon and this name display 
when you open the Data tab in BGAN LaunchPad.  

3. Select an IP Data service. This can be either Standard or Streaming. 
• If you chose Standard, no further configuration is required in this part of the screen. Go to 

step 4.  
• If you choose Streaming, the Streaming Parameters section of the window activates. 

You can do the following in the Streaming Parameters section of the window: 
a. Select the Desired Rate from the drop-down list. This is the symmetrical rate that 

you want to use for this connection.  
b. Select the Minimum Rate from the drop-down list. This is the minimum symmetrical 

rate that you will accept for this connection. Inmarsat recommends that you set the 
Minimum Rate to the same as the Desired Rate, to ensure that you are allocated the 
data rate that you require. 

c. Change Error correction status. Error correction is turned off by default. Inmarsat 
strongly recommends that you do not turn on error correction, unless instructed to 
do so.  

4. If the drop-down box is activated, select an APN from the Select APN drop-down list. If it is 
not activated, only the default APN is available.  

5. In the IP Configuration section, set up your IP Address requirements. Select either Use 
Dynamic (Network Assigned IP Address) or Use Static IP Address. If you select Use 
Static IP Address, enter the IP Address in the text box.  
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6. In the IP Configuration section, set up your DNS Server requirements. Select either Use 
Dynamic (Network Assigned) DNS Servers or Use Static DNS Server. If you select 
Use Static DNS Server, enter a Primary DNS Server and, if required, a Secondary DNS 
Server in the text box.  

7. If required, check the Use Header compression check box to turn on header compression. 
8. Click on Apply to save the displayed configuration, and continue editing the connection, click on 

OK to save the displayed configuration and exit the configuration screens, or click on Cancel to 
edit without saving.  

 
If you want to add another data connection to the profile, click on Add New Connection in the 
Connections tab. 
 

3.2. Configuring Restrictions 
Using the Settings tab, you can set restrictions on the selected profile. To set restrictions: 
 
1. Click on the Settings tab. The Settings screen displays, as shown below: 

 

 
 

2. Select one of the radio buttons. The options are as follows: 
• No restriction – the user can change all BGAN LaunchPad settings. 
• Medium restriction – the user cannot change data connections or associated settings, but 

can change most other BGAN LaunchPad settings. 
• Maximum restriction – the BGAN LaunchPad user cannot change data tab settings, APN 

settings, auto-connection settings and terminal interface settings, but can change other BGAN 
LaunchPad settings. 

 
3. If required, check the Disable control of all open connections in a device check box. This 

ensures that users cannot edit connections owned by other users. 
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Refer to the following sections for details on which BGAN LaunchPad options are affected by the 
selection you make here. 
 
No restriction 
This is the lowest level of security available. The No restriction allows any user who has a login and 
password for this profile to access all BGAN LaunchPad menu options. 
 
Medium restriction 
The medium restriction setting prevents any user who has a login and password for this profile from 
editing data connections or associated settings in BGAN LaunchPad. The medium restriction setting 
affects only the BGAN Services menu option in BGAN LaunchPad, as shown below: 
 

 
 
The user cannot access any of the greyed out menu options, that is, they cannot edit any of the data 
tab options or associated settings, such as routing information or automatic connection settings. The 
user can still edit telephony settings and TCP Accelerator status, and use all the options in other 
BGAN LaunchPad menus. 
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Maximum restriction 
The maximum restriction setting prevents any user who has a login and password for this profile 
from accessing most of the options in the Terminal and BGAN Services menus in BGAN 
LaunchPad. The user cannot edit data connection settings, cannot change telephony settings, and 
cannot perform most terminal management and interface functions. The maximum restriction 
setting affects the following menus: 
 
• In the Terminal menu, the user cannot use the greyed out options as shown below: 

 

 
 
(The menu shown is for the HNS 9201. The greyed out options may be different for other 
terminals.) The user can change the terminal or terminal interface being used, connect manually 
to the terminal, and restart the terminal.  
 

• In the BGAN Services menu, all data management options and telephony settings are greyed 
out and unavailable, as shown below: 
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3.3. Configuring Support details 
Using the Support tab, you can enter the Support contact details for your organization that will 
display alongside the BGAN offline support and Service Provider support information in BGAN 
Launch Pad. To set up support details: 
 
1. Click on the Support tab. The Support window displays, as shown below: 

 

 
 

2. Either: 
• If no user support is available, click on the No user support available check box, or 
• Enter the details of the available user support in the Email, Website and Telephone 

number text boxes. Remember that this is the support provided by your organization – 
Service Provider support information is already displayed in BGAN LaunchPad. If one of these 
support options is not available, click the appropriate None Available check box. 
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This information displays as shown in the column headed Other Support below, when you click on 
the Support tab in BGAN LaunchPad: 
 

 
In this example, data has been entered for email and telephone contacts, but not for website 
contact. 
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3.4. Saving User information 
After you have completed all screens in the User Profile Maker, click on Save. The User 
Information window displays, as shown below: 

 

This window enables you to create a user login and password for use with this profile, or to create 
multiple user logins for use with this profile.  
 
To create one or more user logins for the current profile: 
  
1. Type a user name in the User name text box. 
2. Type a password in the Password text box. 
3. If you want to associate additional logins with this profile, click the Create multiple different 

images with different user names and passwords check box. An Add button displays 
beneath the Password text box. 

4. Click on Add. The user login displays in the login table. 
5. Repeat steps 1, 2 and 4 for each additional user login you want to create. 
6. Click on Save when you have created all required logins. A dialog box opens, enabling you to 

browse through the directory structure on your computer, and save the user profile(s) in the 
required directory. 
By default, you must save the user profiles to the following directory: 
• On a Windows PC: C:\Program Files\Inmarsat\LaunchPad\com\mmi\userprofiles. 

Each user and their profile is saved as an .xml document. 
• On a Mac: Applications\Inmarsat\LaunchPad\com\mmi\userprofiles. Each user and 

their profile is saved as an .xml document. 
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4.0. Logging in to BGAN LaunchPad (Corporate Edition) 
When you have created and saved one or more user profiles using User Profile Maker, these 
profiles are available for use next time a user logs in to a BGAN LaunchPad session. 
To start BGAN LaunchPad on your computer: 
 
1. Click on the BGAN LaunchPad icon on your desktop: 

 

 
 
The Log in dialog box displays, as shown below: 
 

 
 

2. Select your user name from the User Name: drop-down list. The listed usernames must have 
been set up as described in “Saving User information” on page 17  
 

3. Type your password for this username in the Password text box. The password must have 
been set up as described in “Saving User information” on page 17. 
 

4. Click on OK. Depending on your Terminal's configuration, the Authenticate SIM PIN dialog 
box may display, as shown below: 
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5. Enter the SIM PIN and click on OK. The BGAN LaunchPad main window displays, as shown 
below: 
 

 
  
The options available to you depend on the profile created for this login using User Profile Maker. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



20/23    Using the User Profile Maker 

  
 

 

5.0. Editing or Duplicating a Profile 
If you want to edit a profile, or create a new profile that is identical to or similar to an existing user 
profile you can open the existing profile in User Profile Maker, edit the profile as required, and save 
the profile. To do this: 
 
1. Click on the User Profile Maker icon on your desktop: 

 

 
 
The General tab of the User Profile Maker screen is displayed. 

2. Click on File > Open. A dialog box opens, enabling you to browse through the directory 
structure on your computer, and find the user profile that you want to import for editing. (Refer 
to “Saving User information” on page 17 for details on the default directory.)  

3. Select the required profile, and click on Open. A screen similar to the following displays: 
 

 
The details of the selected profile display in the General tab, and include the profile name, the 
names of the data connections associated with the profile, and the restriction level. 

4. Edit the profile as described in “Creating a User Profile” on page 5.  
5. Click on Save to save the profile with the current settings. The User Information window is 

displayed. 
6. Refer “Saving User information” on page 17 to for details on saving user information. You can 

either save the profile with the same name, if you are editing the profile, or with a different name 
if you are creating a new profile. 
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6.0. Setting up a Profile – Example 
This section describes how you would set up an example profile for use with BGAN LaunchPad. 
Before you set up a profile, you must decide on the following: 
• How many IP Data connections do you need, and what do you want them to do. 

o If you want to use basic email, FTP and web browsing applications, in most cases you need 
only a Standard IP data connection, shared by all applications and users. 

o If you want to use video streaming or audio streaming applications, where a guaranteed QoS 
is critical, you can set up one or more Streaming IP data connections, at different data rates. 
These Streaming IP connections guarantee a selected QoS, and can be opened as an 
alternative to the Standard IP connection. This connection type is also shared by all 
applications and users. 

o If you want to ensure that the traffic for a particular application is assigned its own data 
connection, you can set up one or more dedicated IP data connection, each assigned to a 
specific application.  These dedicated IP connections require a Standard IP or Streaming IP 
data connection to be open, as they use the same APN information as the open connection.  

o If you want to open an inclusive tunnel VPN, you can set up a VPN connection. 
• What level of restriction you want to apply to users. You can give users unlimited access, you 

can prevent users from editing data connections and related settings, or you can prevent users 
from editing all data connections and terminal settings. 

• Whether you want to publish support contacts for your organization in BGAN LaunchPad. 
 

6.1. Example profile 
In this example, the BGAN administrator wants to set up a Standard IP data connection, one 
Streaming IP data connection at 64kbps, and a Dedicated IP data connection for QuickLink traffic. 
The administrator also wants to prevent users from editing the data connections, and wants to 
publish the organization’s telephone and email support contact details in BGAN LaunchPad. To set 
up this profile: 
 
1. Open the User Profile Maker. 
2. Click on the Connections tab, then click on Add new connection, as described in 

“Configuring Data Connections” on page 6. 
3. Click on Create new Standard IP or Streaming IP Data Connection, and click on OK. 

The Primary Connection screen displays. 
4. Create the Standard IP data connection. Refer to “Configuring Data Connections” on page 6 

for details. 
5. Click on Create new Standard IP or Streaming IP Data Connection, and click on OK. 

The Primary Connection screen displays. 
6. Create the Streaming IP data connection. Remember to select 64k from the drop-down lists 

for Desired rate and Minimum rate. Refer to “Configuring Data Connections” on page 6 for 
details. 

7. Click on Create new Dedicated Streaming IP Data connection and click on OK. The 
Dedicated connection screen displays. 

8. Create the Dedicated IP data connection. Remember to select Quicklink from the Application 
traffic flow template drop-down list. Refer to “Configuring Data Connections” on page 6 for 
details. 

9. Click on the Settings tab. 
10. Select Medium restriction, which is the level of access that prevents users from editing the 

data connections. Refer to “Configuring Restrictions” on page 12 for details. 
11. Click on the Support tab. 
12. Enter the email support address, and the support telephone number that you want to display in 

BGAN LaunchPad. Remember that this should be specific to your organization. You must also 
click the None Available check box on the Website row (or any row for which you do not 
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want to publish information). Refer to “Configuring Support details” on page 15 for details.  
The Save button activates once this screen is complete. 

13. Click on Save to save the profile and display the User information screen. 
14. Enter details for each user that you want to have access to this profile. Refer to “Saving User 

information” on page 17 for details. 
 
You have now created a profile, and assigned user logins to it. When you or a user next opens 
BGAN LaunchPad, this profiles and its associated logins are available for use. 
 

7.0. Glossary 
APN 
An Access Point Name (APN) identifies an external network that is accessible from a Terminal. An 
APN has several attributes associated with it that define how you can access the external network 
at that point. By default, the SIM Card in your terminal is configured with the APN of your Service 
Provider. You may want to configure further APNs if you have arranged with your Service Provider 
to use more than one SIM Card.  
 
DNS Server 
The Domain Name System (DNS) is an Internet service that is required because the Internet does 
not recognize the text-based Web address or email address that you type into your Web browser 
or email application. All or part of a Web address or an email address is a domain name, and DNS 
translates this domain name into an IP address that is recognised by the Internet. 
A DNS Server holds a database of domain names and IP addresses, so that when you enter a Web 
address or email address, you are sent to the correct IP address over the Internet. 

• Dynamic DNS Server – If you are using dynamic IP addressing, Inmarsat recommends that 
you use a dynamic DNS server. A dynamic DNS server updates the IP address information 
in the DNS database each time your IP address changes. A dynamic DNS server also 
enables a computer using a dynamic IP address to use network applications that normally 
require a static IP address, for example FTP servers. This service requires subscription with 
a Dynamic DNS provider. 

• Static DNS Server – If you are using static IP addressing, Inmarsat recommends that you 
use a static DNS server. If you select this option, you must enter the IP address of the 
Primary DNS Server. This is supplied by your Internet Service Provider. Optionally, you can 
enter the IP address of a Secondary DNS Server, also supplied by your ISP. This is used in 
the event of failure of the Primary DNS Server. 

 
Error correction 
Error correction ensures that very little data is lost during transfer by asking for dropped packets to 
be resent. However, because it holds subsequent data whilst the packet is being resent, you may 
notice some jitter or delay in the received data when error correction is switched on.  
Inmarsat does not recommend the use of error correction because UDP does not require re-
transmission, and TCP has re-transmission built-in. Error correction is turned off by default in 
BGAN LaunchPad. 
 
Header Compression 
A header is the component of a data packet that precedes the data that you are sending. The header 
contains information such as source and destination address, error checking and other 
administrative details. In most data types this does not noticeably affect the data transmission rates. 
However in multimedia applications such as voice and video, the header can significantly affect 
performance. 
Inmarsat recommends that you switch on header compression for multimedia applications, such as 
video. 
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IP Address 
An Internet Protocol address, or IP address, is a number that identifies the computer that is sending 
or receiving information transmitted over the Internet. An IP address is made up of four groups of 
numbers between 0 and 255, separated by periods. For example, 207.115.79.4 is an IP address. In 
the BGAN system, IP addresses can be dynamic or static. 

• Dynamic IP Address – A dynamic IP address is a temporary address that is assigned by your 
Internet Service Provider (ISP) when you connect to the Internet. If you do not need a 
permanent IP address, Inmarsat recommends that you obtain a dynamic IP address. 
Normally, individual users of the Internet use a dynamic IP address. 

• Static IP Address – A static IP address is assigned permanently, and is used every time you 
connect to the Internet. Normally, companies and other organizations that have their own 
networks use static IP addresses. 

 
Quality of Service (QoS)  
Quality of Service (QoS) assigns a level of priority to certain types of data traffic, in particular high 
bandwidth applications such as video and multimedia. QoS attempts to maintain a guaranteed 
throughput level, and minimise error rates and end to end latency, so providing a higher level of 
service than "best effort" protocols. Four levels of QoS are available over the BGAN network: 
32kbps, 64kbps, 128kbps and 256kbps. The QoS rates available to you depend on the terminal you 
are using. 
 
Symmetrical Rate 
The rate at which streaming data is transmitted, in kilobytes (KB). This rate applies to transmitted 
(uplink) and received (downlink) data. 

• Desired Symmetrical Rate – From the drop-down list, choose the desired data rate for 
your Streaming connection. This can be one of the following data rates, depending on the 
terminal: 32 KB, 64 KB, 128 KB or 256 KB. This figure is guaranteed, unless the connection 
cannot meet this requirement because of bandwidth restrictions. In this case the rate 
defaults to the minimum symmetrical rate. 

• Minimum Symmetrical Rate – From the drop-down list, choose the minimum data rate that 
you are prepared to accept for your Streaming connection. This can be one of the following 
data rates, depending on the terminal: 32 KB, 64 KB, 128 KB or 256 KB. If the connection 
cannot meet this requirement, an error message displays. 

 
Traffic Flow Template (TFT) 
A Traffic Flow Template, also called an Application Template, is a series of data filters such as QoS,  
PDP Context and security settings, that allow the GPRS Core Network to classify packets received 
from an external network into the correct PDP Context.  When incoming data arrives at an access 
point in the core network, a packet classifier will make a PDP Context selection based on the Traffic 
Flow Template, and map the incoming data packets into the PDP Context with the correct QoS 
attributes. The use of a Traffic Flow Template allows multiple PDP Contexts to be associated with 
the same PDP address. 
 
Virtual Private Network (VPN) 
A Virtual Private Network enables remote offices or users to gain secure access their organization's 
network over the public telecommunications network. This provides the benefits of remote access 
without the expense of dedicated leased or owned lines. VPNs work by using tunneling protocols, 
such as L2TP, to encrypt data at the sending end, and decrypt the data at the receiving end. This 
"tunnel" cannot be accessed by data that is not properly encrypted.  
 


